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[bookmark: _Toc12339520][bookmark: _Toc13832124]Glossary
Below is an alphabetical list of commonly used acronyms, initialisms, and terms used throughout this document.

· Agency: Agency that maintains a child care and development contract with the California Department of Education, Early Learning and Care Division

· CDD-801A: CDD-801A Monthly Child Care Population Report

· CDE: California Department of Education

· CDMIS: Child Development Management Information System

· Contract: California Department of Education, Early Learning and Care Division child care and development contract

· CR/LF: Carriage Return/Line Feed

· ELCD: Early Learning and Care Division

· FEIN: Federal Employer Identification Number

· FICN: Family Identification Case Number

· File: CDD-801A Monthly Child Care Population Report electronic file

· FIPS: Federal Information Processing Standards

· HoH: Head of Household

· IEP: Individualized Education Program

· PC: Personal Computer

· QRIS: Quality Improvement and Rating System

· Report Period: Month and Year of a CDD-801A Monthly Child Care Population Report

· SMI: State Median Income

· SSN: Social Security Number

· TANF: Temporary Assistance for Needy Families

· Vendor: Software vendor who has expressed interest in working with Early Learning and Care-contracted agencies on the electronic reporting of the CDD-801A Monthly Child Care Population Report

Below is an alphabetical list of current Early Learning and Care Division child care and development contract codes with descriptions.

· C2AP: CalWORKS Stage 2
· C3AP: CalWORKS Stage 3
· CAPP: Alternative Payment Program
· CCTR: General Childcare and Development Program
· CFCC: Family Childcare Home Education Networks
· CHAN: Severely Disabled Program
· CMAP: Migrant Alternative Payment Program 
· CMIG:  Migrant Child Care and Development Programs
· CRRP: Resource and Referral Program
· CSPP: California State Preschool Program
[bookmark: _Toc12280666]
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[bookmark: _Toc12280667][bookmark: _Toc13832126]Overview
The purpose of this document is to provide agencies maintaining a child care and development contract (contract) with the California Department of Education (CDE), Early Learning and Care Division (ELCD) with the technical description and format specifications of a CDD-801A Monthly Child Care Population Report (CDD-801A) electronic file (file) as well as comprehensive instructions for structuring, creating, and reading a file.

[bookmark: _Toc13832127]Contents
This document contains the following sections and topics:

· Background Information
· Section A: Electronic File Technical Description
· Section B: Electronic File Format Specifications
· Section C: Structuring an Electronic File
· Section D: Reading an Electronic File
· Section E: Creating an Electronic File
· 

[bookmark: _Toc13832128]Background Information
Agencies maintaining a contract with the CDE, ELCD may utilize the CDD-801A Electronic File Transfer function of the Child Development Management Information System (CDMIS) website to fulfill the CDD-801A requirement. The uploaded file contains all family, child, and provider information for a given report month and year (report period). 

Step-by-step instructions for submitting the CDD-801A via the Electronic File Transfer method is available in Chapter 3: CDD-801A Reporting of the CDMIS User Manual.


[bookmark: _Toc13832129]Section A: Electronic File Technical Description
This section provides technical descriptions of the various components of a file.

[bookmark: _Toc13832130]File Name
Agency-Assigned
Agencies maintaining a contract with the ELCD (agencies) are permitted to name files uploaded to the CDMIS to fulfil the CDD-801A reporting requirements, at their own discretion; however, for convenience and record keeping purposes, the ELCD recommends that file names include the report period and the agency’s vendor number/submission code.

California Department of Education-Assigned
Once uploaded to the CDMIS website, files are assigned a name by the CDE. This name includes the report; report period; agency vendor number/submission code; and date and time of file upload.

The CDE-assigned file name is indicated on the CDD-801A Electronic File Transfer Status Reports screen and is accessible via the CDD-801A Management Reports function.

[bookmark: _Toc13832131]File Format
All files uploaded to the CDMIS must be specifically formatted to meet CDMIS website standards. Specifically, files must maintain the following characteristics:

· Files must be a tab-delimited ASCII text file
· Files must not be compressed (i.e., zipped)

Incorrectly formatted files will not be processed by the CDMIS.

Records (Rows) 
The term “records” is used to refer to the rows of a file:

· Each record in files must end with the standard personal computer (PC) end-of-line characters Carriage Return (CR)/Line Feed (LF).

· Blank records are not allowed in files.

· Files must contain at least one record and no more than 100,000 records.

Fields (Columns)
The term “fields” is used to refer to the columns of a file:

· All 41 fields indicated in Section B: File Format Specifications must appear in files, even fields with null or blank values.

· All fields are delimited (separated) by tabs, except the last one, which is followed by a CR/LF.

· The use of two tabs next to each other indicates a blank field.

· Fields must not be padded with spaces.

· Fields must not contain control characters or format symbols.

· If a field is marked as required, null values (no data) are not allowed.

· Field lengths may be less than the specified length if the data size column includes "Max and Min sizes" but can never exceed the maximum. If the data size column includes a specific field size, the field must be exactly that length.

Data
[bookmark: TechDescriptionJuly2013Later][bookmark: StructuringContentsJuly2013Later]Within each field, data elements must be specifically formatted. Each field contains different data format specifications.

General descriptions of the format of the different data elements are presented below:

· Character fields can contain both upper- and lower-case letters, numbers, and dashes, unless otherwise noted.

· Number fields must contain only numbers.

· Date fields must contain dates in the format mm/dd/yyyy.

Detailed descriptions of the format of the different data elements of a file are presented in the following section, Section B: File Format Specifications.
[bookmark: _Toc12279566]

[bookmark: _Toc13832132]Section B: Electronic File Format Specifications
This section provides detailed information of format specifications for each data field within a file. 

Within a file, all data elements must be specifically formatted and meet specific criteria. The below table outlines each data element of a file. Additionally, the table below provides descriptions and comments of each data element, including the data type, size, and entry requirement.

C: Character (upper- and lower- case letters, numbers, dashes, etc.)
N: Numbers only
	Field #
	Field Letter
	Data Element Description
	[bookmark: _ftnref1]Data Type
	Data Size
	Entry Required?
	Comments

	1
	A
	Report month and year
	C
	7
	Yes
	Required format is mm/yyyy. Example: January 2019 must be entered as 01/2019.

	2
	B
	[bookmark: _ftnref2]Vendor number/
Submission code 
	C
	7
	Yes
	Example: Vendor number Z987 and Submission code 000 is entered as Z987000.

	3
	C
	FICN
	C
	Max. 15
	Yes
	Only letters A-Z (both upper and lower case are acceptable) and numbers 0-9 are allowed. For each family you must report the FICN.

	4
	D
	HoH SSN
	N
	9
	No
	The SSN field is no longer used. This field must remain blank when reporting.

	5
	E
	HoH Last Name
	C
	Max. 50; min. 2
	Yes
	Only letters, hyphens, spaces, and apostrophes are allowed.

	6
	F
	HoH First Name
	C
	Max. 50; min. 2
	Yes
	Only letters, hyphens, spaces, and apostrophes are allowed.

	7
	G
	HoH Middle Initial
	C
	1
	No
	This field must be included in the file, even if it is blank.

	8
	H
	HoH Zip Code
	N
	9
	Yes
	Numbers only; do not include dash. Example: 999999999 (Five digit zip code + 4 digit extension)

	9
	I
	TANF/
CalWORKs Cash Aid Recipient?
	C
	1
	Yes
	3 valid entries are: Y (yes), N (no), or U (unknown).

	10
	J
	Family Income Greater Than 70 Percent of the SMI Level?
	C
	1
	Yes
	3 valid entries are: Y (yes), N (no), or U (unknown).

	11
	K
	Family Size
	N
	2
	Yes
	Numbers only; 0-9

	12
	L
	Family Income
	N
	4
	Yes
	Numbers only; 0-9; no decimals.

	13
	M
	Reason for Receiving Child Care
	C
	1
	Yes
	Only 9 valid entries: A, B, D, E, F, G, H, J, Q.

	14
	N
	HoH FIPS Code
	N
	5
	Yes
	This field must contain five digits. Example: 06001, 06003. Leading zero must be included.

	15
	O
	Family Start Date
	Date
	10
	Yes
	Required format is mm/dd/yyyy (include the slashes). Example: September 2, 2019, must be entered as 09/02/2019.

	16
	P
	Child's Last Name
	C
	Max. 50; min. 2
	Yes
	Only letters, hyphens, spaces, and apostrophes are allowed.

	17
	Q
	Child's First Name
	C
	Max. 50; min. 2
	Yes
	Only letters, hyphens, spaces, and apostrophes are allowed.

	18
	R
	Child's Middle Initial
	C
	1
	No
	This field must be included in the file, even if it is blank.

	19
	S
	Child's Ethnicity
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	20
	T
	Child's Race: American Indian or Alaskan Native
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	21
	U
	Child's Race: Asian
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	22
	V
	Child's Race: Black or African American
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	23
	W
	Child's Race: Native Hawaiian or Other Pacific Islander
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	24
	X
	Child's Race: White
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	25
	Y
	Child's Gender
	C
	1
	Yes
	2 valid entries; M (male) or F (female).

	26
	Z
	Child's Date of Birth
	Date
	10
	Yes
	Required format is mm/dd/yyyy (include the slashes). Example: September 2, 2019, must be entered as 09/02/2019.

	27
	AA
	Child Has IEP
	C
	1
	Yes
	2 valid entries: Y (yes) or N (no).

	28
	AB
	Child's Primary Language
	N
	2
	Yes
	This field must contain 2 digits. Example: 02, 04, etc. Leading zero must be included. See list of language codes on ELCD-9600 Confidential Application for Child Development Services and Certification of Eligibility form and Data Definitions.

	29
	AC
	Child is English Learner
	C
	 
	Yes
	3 valid entries; Y (yes) or N (no), or blank.

	30
	AD
	Child Start Date
	Date
	10
	Yes
	Required format is mm/dd/yyyy (include the slashes). Example: September 2, 2019, must be entered as 09/02/2019.

	31
	AE
	Child Receives Part-Time Care?
	C
	1
	Yes
	2 valid entries; Y (yes) or N (no).

	32
	AF
	Provider FEIN/SSN
	N
	9
	Yes
	Numbers only; do not include dashes (-).

	33
	AG
	Provider FIPS Code
	N
	5
	Yes
	This field must contain five digits. Example: 06001, 06003. Leading zero must be included.

	34
	AH
	Provider Zip Code
	N
	9
	Yes
	Numbers only; do not include dash. Example: 999999999 (Five digit Zip Code + 4 digit extension)

	35
	AI
	QRIS Participation
	C
	1
	Yes
	The field must contain a single digit.
Four valid entries are:
0 – No: Provider is eligible but does not participate in QRIS
1 – Yes: Provider does participate in the QRIS
7 – There is an operating QRIS in the provider’s area, but the provider is not eligible to participate
8 – There is no operating QRIS in the provider’s area

	36
	AJ
	Accreditation Status
	C
	1
	Yes
	The field must contain a single digit.
Six valid entries are:
0 – No
1 – Yes: National Accreditation
2 – Yes: State Accreditation
3 – Yes: Other Accreditation (not National or State Level)
4 – Yes: Level/Type of Accreditation Unavailable
9 – NA: Information Currently Unavailable

	37
	AK
	Type of Child Care
	N
	2
	Yes
	This field must contain 2 digits. Example: 02, 04, etc. Leading zero must be included.

	38
	AL
	Program Code 1
	C
	4
	Yes
	Program Code 1 is required.

	39
	AM
	Program Code 2
	C
	4
	No
	This field should only contain data if the child receives services from more than one program code. This field must be included in the file, even if it is blank.

	40
	AN
	Program Code 3
	C
	4
	No
	This field should only contain data if the child receives services from more than two program codes. This field must be included in the file, even if it is blank.

	41
	AO
	Services Date
	Date
	10
	Yes
	Required format is mm/dd/yyyy (include the slashes). Example: September 2, 2019, must be entered as 09/02/2019.


[bookmark: _ftn1]
Note Regarding Vendor Number/Submission Code: The default submission code for agencies that do not report by sub-agency is "000". If an agency has created sub-agencies for reporting purposes, then each sub-agency has its own submission code. The list of submission codes for each agency is available on the Sub-agency/No Services screen of the CDMIS website.


[bookmark: _Toc13832133]Section C: Structuring an Electronic File
This section provides detailed instructions for structuring files.

[bookmark: _Toc13832134]Content
The following sub-sections are provided in this section:

· C.1 One-Child Family
· C.2 Multi-Child Family


[bookmark: _Toc13832135]C.1 One-Child Family
Family Data
Below is fictional information about a family with only one child receiving subsidized child care services through an agency’s contract with the ELCD.

· In August 2013, Agency X (vendor number/submission code “Z987000") provided subsidized child care services through a contract with the ELCD to the Alice A. Adams family. Alice is the parent/Head of Household (HoH).

· Agency X assigned the Family Identification/Case Number (FICN) "A9910" to Alice.

· Alice's Social Security Number (SSN) is 123-45-6789; however, as of the October 2018 CDD-801A, the CDMIS no longer accepts HoH SSNs. Even though the CDMIS no longer accepts HoH SSNs, the blank SSN field must be included in the row.

· Alice’s home zip code is 95814-1292; she lives in Sacramento County (Federal Information Processing Standards [FIPS] code "06067").

· Alice did not receive Temporary Assistance for Needy Families (TANF) (No = "N"), and her income was not greater than 70 percent of the State Median Income (SMI) level (No = "N").

· Her reason for receiving child care was "Employment" ("D").

· Alice has one child, Ann B., who was born 04/06/2010.

· There is no active Individualized Education Program (IEP) in the family file for Ann.

· Ann's primary language is English.

· Ann is not an English Learner.

· Ann began receiving services on 08/14/2013.

· Ann is not of Hispanic or Latino Origin and Alice has indicated that Ann’s Race is American Indian or Alaskan Native.

· Ann is certified to receive 3.5 hours of subsidized child care services through the agency’s contract with the ELCD, three days a week. Because she is certified to receive less than four hours of care on a given day, Ann is reported as receiving part-time care.

· Ann is certified for one type of child care: "License center-based care" (type of child care code "04").

· Ann's care was provided by Kiddie Care Center in Sacramento County. The zip code of the licensed center at which she subsidized child care services through the agency’s contract with the ELCD is 95814-1234.

· Kiddie Care Center participates in the Quality Improvement and Rating System (QRIS) program.

· Kiddie Care Center is accredited through a state operated accreditation program.

· Kiddie Care Center's Federal Employer Identification Number (FEIN) is 23-4567890.

· Ann's care was funded exclusively by the CSPP; even though there is only one program code (i.e., CSPP), the two remaining blank fields must be included in the row.

Family Record
The sample record below displays how the family, child, and provider information detailed above, must be structured.

Two symbols are used in the examples below to represent required formatting:

· “>” is the symbol used for the tab separation that must appear between each field
· “@” is the symbol for CR/ LF which indicates the end of each record

The example record below is broken into four distinct rows, which represent the following: 1) agency and report period; 2) family; 3) child; and 4) provider. 

Note: An actual file to be uploaded to the CDMIS would have all four sections together on the same row.

08/2013>Z987000>
A9910>>Adams>Alice>A>958141292>N>N>3>1500>D>06067>08/14/2013>
Adams>Ann>B>N>Y>N>N>N>N>F>04/06/2010>00>N>08/14/2013>Y>
234567890>06067>958141234>1>2>04>CSPP>>>08/14/2013@


[bookmark: _Toc13832136]C.2 Multi-Child Family
Family Data
Below is fictional information about a family with three children receiving subsidized child care services through an agency’s contracts with the ELCD.

Suzie Smith has three children: Milly, Barry, and Donny. Agency Z987 began claiming the days of enrollment of Susie’s children for fiscal reimbursement purposes under their contract with the ELCD on September 14, 2012.

The current report month is July 2013. All three children receive subsidized child care services through the agency’s contract with the ELCD from the same provider. The provider participates in the local QRIS and received accreditation from the National Association for the Education of Young Children. 

Barry and Donny are twins and started receiving subsidized child care services on September 14, 2012, in CSPP. 

Milly began receiving services on July 5, 2013, when she was about four months old. 

Milly received full-time care in July 2013 and has an active IEP in the family file. The other two children, Barry and Donny, only received two to three hours of care each day during this report period.

All three children speak English as their primary language and are not English Learners.

Family Records
The sample records below display how the family, children, and provider information detailed above, must be structured.

Two symbols are used in the examples below to represent required formatting:

· “>” is the symbol used for the tab separation that must appear between each field
· “@” is the symbol for CR/LF which indicates the end of each record

The example records below are broken into four distinct rows, which represent the following: 1) agency and report period; 2) family; 3) child; and 4) provider. Three records are included to represent the services provided to each child within the family. Because all children are from the same family, the family’s information (fields 1–15) are exactly the same in all three rows.

Note: An actual file to be uploaded to the CDMIS would have all four sections together on the same row.

07/2013>Z987000>
SS1832>>Smith>Suzie>>958141234>Y>N>4>3000>D>06067>09/14/2012>
Smith>Milly>>N>Y>N>Y>N>N>F>03/10/2013>Y>00>N>07/05/2013>N>
987987987>06067>958284321>1>1>04>CCTR>>>07/05/2013@

07/2013>Z987000>
SS1832>>Smith>Suzie>>958141234>Y>N>4>3000>D>06067>09/14/2012>
Smith >Barry>>N>Y>N>Y>N>N>M>06/14/2009>N>00>N>09/14/2012>Y>
987987987>06067>958284321>1>1>04>CSPP>>>09/14/2012@

07/2013>Z987000>
SS1832>>Smith>Suzie>>958141234>Y>N>4>3000>D>06067>09/14/2012>
Smith >Donny>>N>Y>N>Y>N>N>M>06/14/2009>N>00>N>09/14/2012>Y>
987987987>06067>958284321>1>1>04>CSPP>>>09/14/2012@




[bookmark: _Toc13832137]Section D: Reading an Electronic File
This section provides detailed instructions for reading files.

[bookmark: _Toc13832138]Reading Rows
[bookmark: StructuringRowsJuly2013Later]Each row in a file contains three levels of information:

1. Family information
2. Child information
3. Provider information

Rows must be grouped in a very specific way:

· All children in one family must be grouped together
· All providers/types of care for one child must be grouped together

Multiple rows must be submitted for a family when one or more of the following occur:

· A family has more than one child receiving subsidized child care services through an agency’s contract with the ELCD

· A child is certified to receive subsidized child care services through an agency’s contract with the ELCD from more than one provider

· A child is certified to receive subsidized child care services through an agency’s contract with the ELCD in more than one setting

If there are multiple rows for one family, all information for the family (fields 1–15) must be exactly the same in all those rows. 

If there are multiple rows for one child (i.e., a child that had more than one provider during the report period), all information for the child (fields 16–31) must be exactly the same in all those rows. 

If there is only one program code in the row, it must appear in field 38; fields 39 and 40 must be included, even if they are null or blank.

Examples
The below table details the number of rows a file should maintain in different hypothetical family situations. Explanations are provided for each situation.

	If a family has the following
	Then the file contains the following
	Explanation

	1 child who received 1 type of child care
	1 row
	This is the basic format for reporting a family with one child and one provider.

	3 children who each received child care from the same provider
	3 rows (one for each child)
	All children are from the same family, so the family information is exactly the same in all three rows. 

All children received subsidized child care services from the same provider, so the provider information is exactly the same in all three rows.

	1 child who received 2 types of child care from different providers
	2 rows (one for each provider)
	Only one child received subsidized child care services, so the family and child information are exactly the same in both rows.

	1 child who received child care from 2 providers and 1 child who received child care from 1 provider
	3 rows (two rows for the first child, 1 row for the second child)
	For the first child, the family and child information is exactly the same in both rows.

	1 child who received 2 types of child care from 1 provider (for example, "License-exempt in child's home by a relative" and "License-exempt outside child's home by a relative")
	2 rows (one row for each type of child care)
	Only one child received subsidized child care services, so the family and child information is exactly the same in both rows. 

The provider FEIN/SSN is the same in both rows. Even though the child received subsidized child care services from the same provider, the type of child care (setting) is different. An example is when the child's grandmother provides the child care in both the child's home on some days and in her own home on some days.

	1 child who received child care from the same provider, in the same type of child care, but under 2 contract codes
	1 row
	The row has three fields for contract codes. In this example, the first two fields would contain the contract codes and the third field would be blank.


[bookmark: CreatingFromExisting]

[bookmark: _Toc13832139]Section E: Creating an Electronic File
Data properly formatted in tab-delimited text files can be uploaded to the CDMIS via the CDD-801A Electronic File Transfer function to meet CDD-801A reporting requirements. This section provides an overview of the different methods that can be used to create these files.

[bookmark: _Toc13832140]Content
The following sub-sections are provided in this section:

· E.1 Using an Existing Computer System
· E.2 Using a Spreadsheet Application
· E.3 Using a Database Application
· E.4 Using a Software Vendor


[bookmark: _Toc13832141]E.1 Using an Existing Computerized System
The flexibility of agencies’ existing computerized systems determines what files agencies can transfer to the CDMIS. PC-based databases, such as Microsoft Access, FileMaker, and FoxPro, can easily create tab-delimited text files. Mini-computer systems and mainframes may need special programming to create PC-readable electronic files. 

The primary limitation to creating files is reconciling the files and fields between agencies’ existing systems and the CDMIS. The electronic file structure for the CDMIS is fixed; existing data must conform to the fields required by the CDMIS.

Reconciling two systems' file formats and fields is the most difficult part of the process. Examples of fields that may require reconciliation are as follows:

· If the child's date of birth is stored in an existing system in the format m/d/yy (for example, 8/4/05), then that field must be re-formatted as mm/dd/yyyy (08/04/2005) in the file for the CDMIS.

· If the child's last name in an existing system is 75 characters long, that name will not fit into the CDMIS 50-character child last name field.

· If an existing system does not store all of the required information, an agency may be unable to create a file.



[bookmark: _Toc13832142]E.2 Using a Spreadsheet Application 
Spreadsheet applications, such as Microsoft Excel (Excel), allow agencies to apply special formatting to each column to meet the formatting requirements, and save data as a tab-delimited text file.

[bookmark: _GoBack]Spreadsheet Templates
Agencies can create spreadsheet templates to input or format data, and create tab-delimited files that can be transferred to the CDMIS.

Spreadsheets must be built to contain all the fields described in Section B: Electronic File Format Specifications. Files MUST be constructed with the EXACT format shown (i.e., all fields must be in the proper order, even if they are not populated with data). To export data, saving a file as a "tab-delimited text file" is appropriate in most cases. 

When using spreadsheets, remain mindful of the following best practices when working with files:

· DO

· Have a working knowledge of the spreadsheet application 
· Utilize custom formatting for each column of data
· Exercise caution when altering file contents 
· Save as a tab-delimited text file

· DO NOT

· Allow the spreadsheet application to auto-format file contents (i.e. dates, numbers) 

· Add headers or punctuation (i.e. commas, quotation marks, periods, parentheses) to or between data fields

· Delete spaces between data fields 

· Save as an XLS or XLSX file type, if using Excel

Management Reports
Agencies can use CDD-801A management reports to create tab-delimited files that can be transferred to the CDMIS.

Step-by-step instructions for downloading a CDD-801A Management Report as an Excel file from the CDMIS and converting an Excel file to a properly-formatted tab-delimited text file for transfer to the CDMIS, are provided below.

Downloading CDD-801A Management Reports

1. Select the function "CDD-801A Management Reports" from the Main Menu of the CDMIS Production website. Click the “Submit” button.

2. On the CDD-801A Management Reports screen, click the "CDD-801A Submission Export" hyperlink.

3. Indicate the desired report period, and sub-agency (if applicable). Click the “Submit” button.

4. Scroll to the bottom of the CDD-801A Electronic File Transfer Status Report screen and click the "Download this Screen to Excel File" button.

Converting an Excel File to a Tab-Delimited Text File

1. Open the downloaded CDD-801A Electronic File Transfer Status Report in Excel

Adding Fields (Columns)

2. Select Column "A" and right click on the mouse

3. Insert 2 blank columns to the left of Column "A"

Result: The new Column “A” will be the Report Month and Year (Field Number 1, Field Letter A). 

The new Column “B” will be the Vendor Number/Submission Code (Field Number 2, Field Letter B)

4. Click on the "A" at the top of the spreadsheet to select all rows of Column "A"

5. Navigate to the Home Tab on the Excel Ribbon and expand the Number Group 

6. Select the Number Tab of the Format Cells dialog box

7. Click Custom from the Category Menu

8. In the Type Field, enter mm/yyyy

9. Click "OK"

10. Navigate to Cell "A5" and enter the report month and year

Result: Excel will automatically reformat entered text to mm/yyyy

11. Copy the same report month and year for all families in the Excel file

12. Navigate to Cell "B5"

13. Enter the agency's vendor number and submission code as XXXXXXX

· The first 4 numbers are the agency's vendor number.

· The last 3 numbers are the agency's sub-agency code. (If an agency does not use sub-agencies in reporting, this code will be 000.)

14. Copy the same vendor number/submission code for all families in the Excel file

Formatting Dates
Steps 15 – 22 are to be used to format the following fields:

· Family Start Date: Field Number 15, Field Letter O
· Child Date of Birth: Field Number 26, Field Letter Z
· Child Start Date: Field Number 30, Field Letter AD
· Services Date: Field Number 41, Field Letter AO

15. Navigate to the indicated column

16. Click on the letter at the top of the spreadsheet to select all rows of that column

17. Navigate to the Home Tab on the Excel Ribbon and expand the Number Group 

18. Select the Number Tab of the Format Cells dialog box

19. Click Custom from the Category Menu

20. In the Type Field, enter mm/dd/yyyy

21. Click "OK"

Result: Excel will automatically reformat all dates in this column to mm/dd/yyyy

22. Repeat steps 1 – 7 for all pertinent fields

Adding Leading Zeroes
Steps 23 – 30 are to be used to format the following fields:

· Head-of-Household FIPS Code: Field Number 14, Field Letter N
· Child's Primary Language: Field Number 28, Field Letter AB
· Provider FIPS Code: Field Number 33, Field Letter AG
· Type of Child Care: Field Number 37, Field Letter AK

23. Navigate to the indicated column

24. Click on the letter at the top of the spreadsheet to select all rows of that column

25. Navigate to the Home Tab on the Excel Ribbon and expand the Number Group 

26. Select the Number Tab of the Format Cells dialog box

27. Click Custom from the Category Menu

28. In the Type Field, enter the following:

a. For Child's Primary Language and Type of Child Care, enter 00

b. For Head-of-Household FIPS Code and Provider FIPS Code, enter 00000

29. Click "OK"

Result: Excel will automatically reformat all values in this column to 00

30. Repeat steps 1 – 7 for all pertinent fields

Deleting Dashes "-"
Steps 31 – 35 are to be used to format the following fields:

· Head-of-Household Zip Code: Field Number 8, Field Letter H
· Provider Zip Code: Field Number 34, Field Letter AH

31. Navigate to Column “H;” click on the "H" at the top of the spreadsheet to select all rows of Column "H"

32. Navigate to the Home Tab on the Excel Ribbon and click Replace… on the Find & Select dropdown menu

33. Enter a single dash (-) in the Find What Field of the Find and Replace dialog box; leave the Replace With Field blank

34. Click "Replace All"

Result: Excel will automatically remove all dashes within the spreadsheet

35. Repeat steps 1 – 4 for Column “AH”

Removing Additional Formatting

36. Navigate to Cell "A1"

37. Click on the "1" at the left of the spreadsheet and drag the cursor down to the "4" to select all contents of rows 1 – 4

38. Right click on the mouse

39. Click Delete from the dropdown menu

Saving the Excel File as Tab-delimited Text File

40. Navigate to the File Tab on the Excel Ribbon and click Save As
41. Browse to the location at which the file will be saved
42. Name the file
43. Select Text (Tab-delimited) (*.txt) from the Save As Type dropdown menu
44. Click “Save”

Result: The file is ready to be uploaded to the CDMIS Test website and/or CDMIS Production website.


[bookmark: _Toc13832143]E.3 Using a Database Application
Database applications are slightly less widespread than spreadsheet applications because of their relatively higher level of complexity and (sometimes) their higher prices. It is thus difficult to provide general instructions for exporting from one system to another.

Generally speaking, the same recommendations made for a spreadsheet apply when creating a file from a database: agencies must base table designs on the file format specifications and respect the order of the fields upon export.


[bookmark: _Toc13832144]E.4 Using a Software Vendor
For agencies’ convenience, the ELCD provides information of software vendors (vendors) who have expressed interest in working with agencies on the electronic reporting of the CDD-801A. Vendor contact information is available on the CDE Vendor Information web page at https://www.cde.ca.gov/sp/cd/ci/vendorinfo.asp.

[bookmark: ApplicationLink]The ELCD provides this list of vendors for agencies’ convenience. Agencies should thoroughly review vendors' products and references before purchase.

The CDE does not endorse any vendors or their products.

[bookmark: ChildCareApp][bookmark: Childplus][bookmark: COPA][bookmark: CoreSolutions][bookmark: Innovasoft][bookmark: laurieseaborn][bookmark: MCT][bookmark: NoHo][bookmark: productivity][bookmark: VendorInfo]Information for Vendors
Vendors who are interested in contracting with agencies to provide reporting services and who would like to have their information made available on the CDE Vendor Information web page, are encouraged to email CDMIS@cde.ca.gov with the following information:

· Company name

· Product name (if applicable)

· Contact information (name, mailing address, phone number, and email)

· Two references (contact name and title, company or organization name, and phone number)

The CDE does not endorse any vendors or their products.
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